
GETTING STARTED

This guide will get you up and running with NVivo.  
It provides steps for installing the software and  

starting a new project, and gives an introduction to  
the NVivo workspace and features.
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How to use this guide
This guide will help you to get up and running with NVivo. It provides step-by-step  
procedures for fundamental tasks, and suggests ideas and techniques to help you move  
forward with your project.

For more information about working with NVivo refer to:

•	 NVivo Help—click the File tab, then click Help and then click NVivo Help.

•	 The QSR website (www.qsrinternational.com)—access video tutorials, the QSR forum, FAQs, 
training and support.

•	 The NVivo Users Group on LinkedIn or follow QSR International on Facebook or Twitter.

NVivo and qualitative research
Many qualitative researchers are interested in evaluating, interpreting and explaining social 
phenomena. They analyze unstructured or semi-structured data like interviews, surveys, field 
notes, web pages and journal articles—and they work in a range of sectors; from social science 
and education to healthcare and business. 

What methodologies does NVivo support?
Researchers usually adopt a qualitative methodology to suit their research question. For 
example, a social scientist wanting to develop new concepts or hypotheses may take a 
‘grounded theory’ approach. A health researcher looking for ways to improve policy or program 
design might use ‘evaluation methods’. NVivo doesn’t favour a particular methodology—it’s 
designed to facilitate common qualitative techniques for organizing, analyzing and sharing 
data—no matter what method you use.

ideasHints, tips and techniques are displayed in these panels.

If you want to share your own tips and techniques — join us on the QSR Forum
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Qualitative vs Quantitative
Qualitative inquiry tends to focus on questions of ‘how’ and ‘why’ rather than the more 
quantitative perspective of ‘how many’ or ‘how often’. While NVivo’s main focus is on 
qualitative analysis, it does provide support for researchers who work with mixed methods. 
For example, you can analyze the open-ended questions in a survey and make comparisons 
based on demographic data—and you can exchange this data with applications like 
Microsoft Excel and IBM SPSS Statistics.

How do I approach my research project?

There is no agreed ‘industry standard’ or prescribed process for approaching a qualitative 
project but there are some recognized strategies and steps you can take—you’ll find some 
suggestions as you work through this guide. It can help to understand that qualitative 
research is an iterative process—for example, this picture shows a path you might take 
when exploring a particular theme:

Remember that NVivo can help you to manage, explore and find patterns in your data but 
it cannot replace your analytical expertise.

Bring in 
interview 
documents

Open and 
explore the 
interviews

Some 
participants 
talk about 
‘balance’ 
– this is 
interesting!  
Make a node 
to collect all 
the references

Do other 
people talk 
about ‘balance’ 
too? Run a Text 
Search query 
to find out

Gather the query 
results in your 
‘balance’ node 
and review all 
the material in 
one place

Display a word 
tree to see how 
people talk 
about ‘balance’

Record your 
insights and 
use this 
memo when 
you write up 
your project
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NVivo key terms 
As you work through this guide you’ll be introduced to a number of key concepts but here are 
some basic terms to get you started:

•	 Sources are your research materials including documents, PDFs, datasets, audio, video, 
pictures, memos and framework matrices. 

•	 Coding is the process of gathering material by topic, theme or case. For example, selecting 
a paragraph about water quality and coding it at the node ‘water quality’.

•	 Nodes are containers for your coding—they let you gather related material in one place so 
that you can look for emerging patterns and ideas. 

•	 Source classifications let you record information about your sources—for example, 
bibliographical data.

•	 Node classifications allow to you record information about people, places or other cases—
for example, demographic data about people. 

Explore the sample project
If you prefer ‘hands on’ learning, feel free to explore and work with the NVivo sample project—
Environmental Change Down East. This is a ‘real-world’ project that illustrates the main features 
of the product. Looking at how the sample project is organized may give you ideas about 
approaching your own project. You can also use the sample data to experiment with queries, 
visualizations and other analysis tools. 

You can access the sample project from the Recent Projects list on the NVivo  
Welcome screen.

If you cannot see the sample project in the list, you can access it from the following locations:

•	 On Microsoft Windows XP:  C:\Documents and Settings\All Users\Shared Documents\
NVivo 10 Samples

•	 On Microsoft Windows Vista and Microsoft Windows 7 and 8: C:\Users\Public\Public 
Documents\NVivo 10 Samples
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Install and activate NVivo for Windows
Before installing, make sure that your computer meets the hardware and software requirements:

Minimum requirements
NVivo supports the following minimum requirements: 

•	 1.2 GHz Pentium III-compatible processor (32-bit) or 1.4 GHz Pentium 4-compatible 
processor (64-bit) 

•	 1 GB RAM or more 

•	 1024 x 768 screen resolution 

•	 Microsoft Windows XP SP2 or later

•	 Approximately 2 GB of available hard-disk space (additional hard-disk space may be 
required for NVivo projects) 

Recommended requirements
The following system requirements are recommended for optimum performance:

•	 2.0 GHz Pentium 4-compatible processor or faster 

•	 2 GB RAM or more 

•	 1280 x 1024 screen resolution or higher

•	 Microsoft Windows XP SP2 or later, or Microsoft Windows Vista SP1 or later, or Microsoft 
Windows 7, or Microsoft Windows 8

•	 Approximately 4 GB of available hard-disk space (additional hard-disk space may be 
required for NVivo projects) 

•	 Internet Explorer 8 or later

•	 Internet connection 

Additional requirements if you want to install and use NVivo’s supplementary add-ons:

•	 For NCapture: Internet Explorer 8 or later, or Google Chrome 21 or later

•	 For the NVivo Add-In for OneNote: Microsoft OneNote (2007 or 2010) and Microsoft Word 
(2007 or 2010)
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Install NVivo
You must have administrator permissions for the computer on which you are installing  
the software. 

If you are running a 64-bit version of Windows 7 or Windows 8, you will have the option of 
installing a 32-bit or 64-bit version of NVivo 10. You should install the 32-bit version of NVivo if 
you want to work with .mov and .qt video files. 

1.	 Locate and double-click the NVivo file that you downloaded—the installation process starts 

automatically. If you are installing from physical media, do one of the following:

•	 �Insert the NVivo 10 USB flash drive—in the root folder double-click  
‘NVivo 10 for Windows (32 bit).exe’ or ‘NVivo 10 for Windows (64 bit).exe’. 

•	 �Insert the NVivo 10 DVD—if the DVD menu does not display automatically, double-click 
the file (NV10Menu.exe). Choose your preferred language and start the installation. 

2.	 Follow the steps to: 

•	 �Select your preferred language for the NVivo user interface (if prompted).

•	� Install any prerequisite components. You may be asked to restart your machine—on 
restart the installation will continue automatically. 

•	 Accept the NVivo license agreement. 

•	� Confirm the location of NVivo program files and choose to include an NVivo icon on 
your desktop.

•	� Choose the supplementary add-ons that you want to install. NCapture is a browser 
extension that allows you to gather material from the web. The NVivo Add-In for 
OneNote allows you to bring your OneNote content into NVivo.

3.	 Click Install and the installation confirmation is displayed.

4.	 Click Finish.

Note: If you work with audio and video files, you may need to install additional codecs—for 
more information, refer to the FAQs area of the QSR website (www.qsrinternational.com). 

Start NVivo and activate your license
You need to activate your NVivo license—this is a simple and secure process that ensures valid 
licenses are used to operate the software.

If you are using a trial version of the software, you do not need to enter a license key, but you 
must activate the trial before you can use NVivo.

To start NVivo and activate your license:

1.	 Double-click the QSR NVivo 10 icon on your desktop.

2.	� In the Welcome to NVivo 10 dialog box, choose to trial the software or enter your license 
key and click OK. You can find the key in the download email from QSR (or on your 
physical media case). To ensure accuracy, we recommend you copy and paste the license 
key from the email.
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3.	� In the License Activation dialog box, enter your details and click Activate—if you are 
connected to the Internet, you can activate immediately.

4.	� In the User Profile dialog box, enter the initials you want to use to identify your work in 
NVivo projects. This is especially useful if you are working with other team members on 
standalone projects—refer to the NVivo Help for more information about teamwork in 
standalone projects. 

5.	� (Optional) Clear the check box if you do not want to participate in the Customer 
Experience Improvement program—click the link to find out more about the program. 

6.	 Click OK. The NVivo Welcome screen is displayed:

 

 
 
Create a new project
You can create a new standalone project (saved as a .nvp file) on your computer or a  
network drive. 

If your organization has purchased NVivo Server, and you have appropriate server user 
permissions, you can create a new server project—refer to the NVivo Help for more information.

1.	 On the NVivo Welcome screen, click New Project. The New Project dialog box opens. 

2.	 Enter a name for this project (and add a description if you want to).

3.	� Click the Browse button and in the Save as type list, make sure NVivo Projects (*.nvp) is 
selected—you can change the default file name and location if you want to.

4.	 Click Save, and then click OK.

You can open the sample project 
to see a real project in action

Create a 
new project 
or open an 
existing one

Access 
comprehensive 
online help and 
link to other 
resources

Stay up-to-date with the latest 
news, tips and videos from the 
NVivo community
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Open a project
You can open a standalone project saved on your computer or a network drive, or (if you 
have access to an NVivo Server) you can open a server project. 

1.	 Click the File tab, and then click Open. 

	 The Open Project dialog box opens.

2.	� Select NVivo Projects from the File or Project type list. If you are working with a 
server project, select NVivo Server Projects and then select the server from the 
Connection name box, then select the project you want to open. 

3.	 Click Open. 

Note: If you are working with server projects you may need to setup a server connection 
and check that you are permitted to access server projects—refer to the NVivo Help for 
more details.

The NVivo Workspace
The NVivo workspace provides easy access to all your project material.

The ribbon 
helps you 
to locate 
all NVivo 
commands

Navigation 
View lets you 
organize your 
material into 
folders

Check the status bar to 
see what is happening 
in your project

Access HelpSee the contents of a folder in List View

Work with your sources, nodes or other 
project items in Detail View. Undock 
Detail View to work in a separate window
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Working with the ribbon 
The ribbon is designed to help you locate commands. Commands are organized into logical 
groups, collected together under tabs. Each tab relates to a type of activity, such as creating 
new project items or analyzing your source materials. 

Navigation View 
Navigation View helps you to organize and easily access all of the items in NVivo:

Drag the 
handle down 
to make more 
room

NVivo provides 
folders for 
your research 
materials. You can 
add folders under 
them to organize 
project items

Click to customize 
Navigation View

Click to see 
folders for all 
project items

Click a button 
to see all the 
folders in the 
group

Quick Access Toolbar - 
customize the commands 
to suit the way you work 

Tabs for accessing 
commands related 
to an activity

Hover over a 
command to see a 
description

The File tab 
for managing 
projects, 
printing 
and setting 
application 
options

Commands are organized in groups
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List View 
When you select a folder in Navigation View, its contents are displayed in List View. In this view, 
you can add new items, open existing items and edit item properties. This List View displays the 
contents of a folder: 

 

Detail View 
When you open an item from List View it is displayed in Detail View. This is an example of an 
interview opened in Detail View:

Double-click an 
item to open it

Right-click on items to 
access a context menu

Display an optional 
column for classification

Drag boundary to 
resize columns

Sort the list 
by clicking on 
column headings

For sources or 
nodes, see the 
assigned color

Open multiple items 
and move through 
them using tabs

You can also undock 
Detail View to work in 
a separate window
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Customize your workspace
You can arrange the workspace to suit the way you like to work. For example, you can minimize 
the ribbon or use the options on the View tab to:

•	 Hide Navigation View to make more room (ALT+F1).

•	 Display List View and Detail View side-by-side, this is particularly useful for drag and drop 
coding (see Code at existing nodes later in this guide).

•	 Undock Detail View into a separate window.

Refer to the NVivo Help for detailed instructions.

Early steps 
Before you import your source material or get started with coding, you could take 
some time to:

•	 Prepare for auto coding—if you have consistently structured sources like 
focus groups or interviews (that ask the same set of questions), you can apply 
paragraph styles to faciliate auto coding in NVivo. Refer to the NVivo Help for 
more information about how to do this.

•	 Create a memo (journal) and state your research questions and record your 
goals. Why are you doing the project? What is it about? What do you expect 
to find and why? What biases do you bring to the project? Update the journal 
regularly to stay focused and to show the evolution of your project. 

•	 Make a model to show the relationships or patterns you expect to find in 
your data based on prior experience or preliminary reading—copy and paste it 
into your journal. 

ideas
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Sharing projects in a team
Many projects involve multiple researchers working together—NVivo provides two ways 
to approach collaboration:

•	 Share projects using NVivo Server—everyone in your team can work on the same 
project at the same time. They can code, annotate and link source content and have 
immediate access to the changes made by other team members.

 
	� Or work in copies of a standalone project and merge them into a master  

project at appropriate intervals—making use of user profiles to track changes.  
You can find out more about this in the NVivo Help.

Preparing for teamwork
Whether you work with NVivo Server or collaborate in a standalone project you  
might want to consider the following:

•	 Appoint a team leader who will keep the team on track and make final coding 
decisions.

•	 Have regular team meetings to discuss interpretations, address issues and assign 
tasks—record the outcomes in a memo.

•	 Have each team member keep a memo to record their progress, including any 
hunches, suggestions or questions—you could also do this in a single ‘teamwork 
journal’.

•	 Early on, have multiple team members code the same collection of sources, then 
compare coding (using coding stripes or a coding comparison query)—this can help 
ensure a consistent approach.

•	 To start with, make a node hierarchy for each team member. After team discussion, 
you can refine, merge and reorganize.

•	 Aim for a clear node structure and use descriptions (in node properties) to make the 
purpose of a node clear for all team members.

You can work 
on standalone 
projects or 
connect to NVivo 
Server to access 
server projects

ideas
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Bring your material into NVivo
Sources are the materials that you want to analyze in NVivo—they can include  
articles, interviews, survey results, audio/video recordings, pictures, web pages or  
social media content.

To import sources, use the options on the External Data tab:

 

Interviews, articles and other documents
You can import interviews, journal articles, reports and any other Word documents or PDFs:

 
 

Add annotations or ‘see also’ links to selected 
text (or to selected regions of the page)

Select text, 
such as this 
paragraph, 
and code the 
text at a node

In PDFs 
you can 
also select 
regions of 
the page, like 
this image, 
and code the 
region at a 
node
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Survey results and other datasets

A dataset contains structured data arranged in records (rows) and fields (columns)—for 
example, a dataset could contain the responses to a survey. 

You can create a new dataset source in NVivo by:

•	 Connecting to SurveyMonkey and bringing in your survey results

•	 Importing data from a spreadsheet, text file or database table.

•	 Importing an NCapture file that contains social media data 

You cannot edit the contents of a dataset once it is imported. Before importing 
spreadsheets, text files or database tables, you should prepare your data and consider how 
you want to use it in NVivo—refer to the NVivo Help for detailed instructions.

 
 

 

Apply filters to see a 
subset of the data

Select a ‘codable’ column and 
gather the contents in a node

View the 
dataset as a 
table or see 
each record in 
a form

Select 
content and 
code it at a 
node

Add annotations 
or ‘see also’ links

Navigate through 
the records
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Audio and video
You can import audio and video in a wide range of formats—refer to the NVivo Help for a 
detailed list. You can play and analyze an audio or video source in Detail View:

•	

When recording audio or video it’s a good idea to reduce background noise, have one person 
speak at a time and place the microphone in a good position. 

Before you import audio or video material, consider any editing requirements. For example, 
if you have hours of video footage, you may want to edit it down to a manageable size—you 
cannot do this editing in NVivo.  When you import media files you can chooose to store them 
inside or outside your project—if you have many large videos, we recommend you store them 
outside the project so that software performance is not compromised. 

Create your own transcripts
You can transcribe your media files in NVivo. In ‘transcribe mode’, you can play and pause the 
media—transcribing as you listen and NVivo will automatically add new rows and timestamps. 
To support this process, you can also use a foot pedal and keyboard shortcuts.

If you have already transcribed the material in a Word document or text file (with correctly 
formatted timestamps) you can import the transcript into the audio or video source. 

When it’s time to code the material, you can code the media directly (on the timeline) or you 
can code the transcript.

Refer to the NVivo Help for more information about creating transcripts.

Work with imported videos 
or videos from YouTube

Code directly on 
the timeline

Add ‘see also’ links and annotations 
to the timeline or to the transcript

A transcript is 
optional—you 
can transcribe 
in NVivo, import 
a transcript 
from Word or 
purchase a 
transcript from 
within NVivo

Select content and 
code it at a node 
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Get your materials transcribed
Creating your own transcripts may bring you closer to your data but it can also be labor 
intensive and time consuming. Instead, you can have your media files professionally transcribed 
using TranscribeMe—an integrated transcription service that offers:

•	 Fast turnaround times

•	 Security and confidentiality 

•	 Competitive transcription rates

•	 High quality, accurate transcripts in an ‘NVivo-ready’ format 

•	 Automatic and seamless download of transcripts into your NVivo project

You can order and purchase transcripts without leaving the NVivo application:

TranscribeMe provide transcriptions in a variety of languages—you can check the available 
languages at the time you place your order.

You will need NVivo 10 for Windows Service Pack 5 or later to use this feature. 

Photos and other images
You can import photos or other images and analyze them in NVivo—refer to the NVivo Help for 
a detailed list of supported image formats. 

A picture source consists of a picture and a text log:

Code 
directly 
on the 
picture

Create a log 
to describe 
the picture 
(or just 
selected 
regions)

If you don’t already have an 
account with TranscribeMe, you 
will be prompted to create one

Transcripts are 
synchronized with your 
audio and video sources

Select audio or 
video sources to 
be transcribed

Get a price and 
place an order

Media files are 
uploaded to
TranscribeMe

Completed 
transcripts are 
downloaded
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Web pages, social media and YouTube videos
NCapture is a browser extension that lets you clip web pages and import them as PDF sources 
in your NVivo project.  

 
You can also capture social media conversations (from platforms like Facebook, Twitter or 
LinkedIn)—and store them as PDF or dataset sources. Having content in a dataset means you 
can sort, filter and auto code (for example, you could gather Tweets by location).

Using NCapture, you can also capture YouTube videos and then work with them in NVivo. You 
may also want to import any comments as a dataset.

For detailed instructions about installing and using NCapture, refer to the NVivo Help.

Save a web page as an NCapture file

Import it as a PDF source

Store social media content in a dataset
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Collect data on mobile devices (with Evernote)
When working in the field, you may want to collect data on a mobile device. For example, you 
could use your smartphone or tablet to:

•	 Record audio or video interviews

•	 Snap photos of participants, white-board diagrams or research settings

•	 Clip web pages and gather articles online

•	 Make notes to record field observations, ideas and insights 

You can use Evernote (a popular cloud-based app) to gather and organize this data when 
you’re out and about. When you’re back at your desk, you can connect to your Evernote 
account (from within NVivo) and import the material.

Refer to the NVivo Help for more information about importing content from Evernote.

Import from OneNote
If you use OneNote, you can use the NVivo Add-In for OneNote to export your pages (to a 
.nvoz file) and bring them into NVivo. 

Refer to the NVivo Help for detailed instructions.

Use Evernote to gather material on your 
smartphone or tablet (Android and iOS)

Then easily bring 
individual notes or 
whole notebooks into 
NVivo. You may also 
want to convert your 
tags to nodes.
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Bibliographical data
If you have conducted a literature review using a bibliographical application like EndNote, 
Mendeley, RefWorks or Zotero—you can export the data from the application as an 
EndNote XML file or RIS file and import it into NVivo. The records are added as sources 
in your project and the bibliographical details are stored as ‘source classifications’ and 
attribute values. 

Literature reviews in NVivo – keeping everything in one place
Using NVivo for your literature review can be a great way to learn the software  
and get started with a project. You can bring in your journal articles and:

•	 Organize them in a source folder called ‘Literature’.

•	 Code each article to gather material by theme—you might also want to make nodes 
for ‘statistics’, ‘good quotes’ and ‘definitions’.

•	 Annotate as you read, marking content for follow-up or futher exploration.

•	 Use memos to describe the key themes and critique the articles.

•	 Use source classifications to assign attributes like publication date and author (you 
can also import these from reference management software like Endnote). Then use 
queries to find everything an author wrote about a theme or everything that was 
written before a certain date.

•	 Use a Word Frequency query to see what common terms are being used.

•	 Use a Matrix Coding query to find gaps in the literature—what themes are already 
heavily discussed and which provide scope for further exploration?

ideas

Source classifications
You can also record bibliographical information by ‘classifying’ your sources in NVivo—when you 
are ready to write up your findings, you can export this data to your reference management 
tool and use its features to insert citations and format the references. Refer to the NVivo Help 
for more information about classifying your sources and working with bibliographical data.

Create externals for the things you can’t import
Externals are ‘proxies’ for the material you cannot import into NVivo such as books, or physical 
artifacts. You can create an external source (that looks like a document) and summarize the 
content of the item—for example, you might enter key points from a PowerPoint presentation 
or summarize the chapters in a book. 

You can then code or annotate this content. If the external represents a file on your computer, 
you can create a link to the file and easily open it from within NVivo.
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Betty’s photo

Betty’s interview

Betty’s node (classified as ‘person’ 
gender=female, community=Straits)

You can also code to gather material about a person, place or other case:

Betty’s and Paul’s video

Coding and making nodes
You can ‘code’ your sources to gather material about particular themes and topics— for 
example, you could create the node water quality and as you explore your sources (documents, 
PDFs, datasets, audio, video or pictures) you could code all references to water quality at the 
node:

Document

Picture

Water quality node

Video
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Approaches to coding
The way you approach coding depends on your methodology and research design 
but here are some ideas to get started:

•	 Start with ‘broad-brush’ coding to organize the material into broad topic areas (you 
can use Text Search queries to help with this)—then explore the node for each topic 
and do more detailed coding. For example, gather all the content about water quality 
and then explore the node looking for interesting perceptions, contradictions or 
assumptions.

•	 Or, you could get straight into detailed coding (making nodes as you need them) and 
then, later on, combine and group your nodes into related categories.

•	 As you reflect on a piece of content, think about these different types of coding:

•	 �Topic coding—What is the topic being discussed? For example, water quality, real 
estate development, tourism and so on.

• 	 �Analytical coding—What is this content really about? Why is it interesting? 
Consider the meaning in context and express new ideas about the data.  
For example, ideals vs reality, tension between developers and residents.

• 	 �Descriptive or ‘case’ coding—Who is speaking? What place, organization or other 
entity is being observed?

The parent node 
has ‘aggregation’ 
turned on. Any 
content coded at 
the child nodes 
is rolled-up 
into the parent 
node—you can 
display a column 
to see this

As you code 
at the node, 
you can see 
the number of 
sources and 
references 
increase

ideas

Add nodes before you start coding
If you already know what themes you are looking for (based on your literature review, for 
example)—you can create and organize the nodes before you start coding:

1.	 In the Navigation View, click Nodes.

2.	� On the Create tab, in the Nodes group, click Node. 

The New Node dialog box opens.

3.	 Enter a name and description.

4.	 Click OK and the new node is added to List View.

5.	 You can add ‘child’ nodes (sub-nodes) under the new node and create a node hierarchy:



25

GETTING STARTED

...and click code

Enter the node ...or select nodes

Code at existing nodes
As you explore your sources, you can code at the nodes you have created: 

1.	� Display your nodes in List View and open a source in Detail View.  You may want to display 
Detail View on the right—on the View tab, in the Workspace group, click Detail View, and 
then click Right.

2.	� Select the content that you want to code. The content you can select depends on the type 

of source you are working with. Refer to the NVivo Help for information about coding in 

different source types.

3.	 Drag the selected content to the node.

	 You can also code by:

•	 Clicking options on the ribbon—on the Analyze tab, in the Coding group, click 
Existing Nodes.

•	 Using keyboard shortcuts—refer to the NVivo Help for more information about 
NVivo keyboard shortcuts. 

•	 Using the Quick Coding bar (at the bottom of Detail View) to code content at 
existing nodes: 

Create nodes as you code
As you explore your sources you can create and ‘code at’ new nodes:

1.	 Open a source in Detail View. 

2.	� Select the content that you want to code. The content you can select depends on the type 
of source you are working with. Refer to the NVivo Help for information about coding in 
different source types. 

3.	 On the Analyze tab, in the Coding group, under Code Selection At, click New Node.

	 The New Node dialog box opens.

4.	 If you want to change the folder location for the node, click the Select button. 
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...and click codeEnter the node

You can right-
click on a 
stripe to open 
a node

Coding stripes 
can reflect the 
colors you have 
assigned to 
nodes—refer 
to the NVivo 
Help for more 
information 
about using color 
in your project

5.	 Enter a name and description. 

6.	 Click OK. 

	� When you create a new node it is added to the selected location in the node hierarchy—you 
can reorganize and work with the node in List View. 

	� You can also use the Quick Coding bar (at the bottom of Detail View) to code selected 
content at new nodes:

Make a node from a selected word (In Vivo code) 
You can also use ‘in vivo’ coding to create and code at new nodes—the selected word or phrase 
is used to name the node and is (at the same time) coded at the node. This is useful if you want 
your nodes to reflect the language of the people you have interviewed.

1.	 Select the text content you want to code.

2.	� On the Analyze tab, in the Coding group, click Code In Vivo (or click Code In Vivo on the 
Quick Coding bar).

See what you have coded 
To see what has been coded in a source, you can: 

•	 Turn on coding highlight—on the View tab in the Coding group, click Highlight, and then 
select a highlight option.

•	 �Turn on coding stripes—on the View tab in the Coding group, click Coding Stripes, and 
then select an option. Coding stripes are displayed on the right of the source:
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Open a node to explore the references 
You can open a node to see related references gathered in one place: 

1.	 In Navigation View, click Nodes. 

2.	� In List View, double-click the node you want to explore. The node is opened in Detail View: 

 

Quick coding based on style or structure
Interview documents can be auto coded based on style or structure—for example, if 
participants are all asked the same set of questions, you can auto code the interviews based on 
paragraph styles.

Datasets can be quickly coded based on their structure too—for example, you can auto code a 
survey dataset to gather all the answers to each question.

The Reference 
tab is displayed 
by default, it 
shows all the text 
content coded at 
the node

Click on these 
other tabs to 
see content from 
pictures, PDFs, 
audio, video and 
datasets

You can select 
content and ‘code 
on’ to new nodes

You can see what sources 
were coded and click on 
the link to open a source

You can set options to 
display more or less of the 
context around a reference

In survey results, you can 
auto code to gather the 
answers to each question.
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Quick thematic coding based on existing coding patterns
If you have a large amount of interview or survey data to code, then you may find pattern-based  
coding useful. 

When you auto code based on existing coding patterns, NVivo uses machine learning 
algorithms to perform ‘broad-brush’ coding of text passages that contain similar words to 
previously coded content.

Pattern-based coding is an experimental feature that you can test and try out (we recommend 
you use NVivo 10 for Windows Service Pack 5)

Refer to the NVivo Help for more detailed information on pattern based auto coding.

For example, if you have a node containing many answers to an 
open-ended survey question—you can start by manually coding 
about ten percent of the responses at descriptive nodes.

Then (based on this pilot coding) you can auto 
code the rest of the responses—NVivo displays the 
results in a matrix and you can refine the coding. 
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Quick coding with Text Search queries 
You can use NVivo queries to automatically code your sources based on the words or phrases 
they contain. This can be a useful starting point for reviewing your data. For example, you could 
run a Text Search query on the word fish and automatically code all occurrences. You can 
search for exact words, phrases or similar concepts. For example, search for fish and find trout, 
mullet, and crab. 

To create a Text Search query—on the Query tab, in the Create group, click Text Search.  
Refer to the NVivo Help for more information about the options you can choose. 

Note: You can also run a Word Frequency query to see the words that occur most often—
for example, if the word housing appears frequently you can save the context around each 
occurrence in a node for further investigation. 

Coding tips
•	 Remember that you can (and should) code content at multiple nodes. For example, 

you could code Barbara’s comment at all of the nodes shown on the left:

•	 If you code all your interviews like this, then you can use queries to gather your 
material in different combinations. For example, show me: 

•	 All the content coded at water quality and development

•	 Negative attitudes about water quality

•	 What women said about water quality

•	 If you find an interesting phrase or theme in one interview, you can use a Text Search 
query to see if it appears in the other interviews—and automatically code the content.

•	 After exploring and coding a source, take some time to reflect on what you have 
discovered. Run a report to see which nodes have been used most often—how do 
these nodes relate to each other? Make a model to explore the relationships and 
record your thoughts in a memo.

•	 You may not need to exhaustively code all your material. For example, if after working 
through twelve interviews you are not finding any new themes or ideas—you may 
have reached ‘saturation’. You could use Text Search queries to do some broad-brush 
coding in subsequent interviews.

ideas
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Memos, annotations and links 
Memos are an integral part of the research process—and can be a great starting point when you 
come to writing-up your project. Memos are like documents and they can be linked to sources 
or nodes.

Annotations are like scribbled notes in the margin—they let you record comments, reminders or 
observations about specific content in a source or node.

Use ‘see also’ links to draw connections between items in your project. For example, you can use 
‘see also’ links to point out contradictions, follow evidence or show a sequence of events.

Creating a linked memo
To create a memo that is linked to a source or node:

1.	 Select the source or node in List View or open it in Detail View.

2.	� On the Analyze tab, in the Links group, click Memo Link, and then click Link to  
New Memo. The New Memo dialog box opens.

3.	 Enter a name for the memo.

4.	 (Optional) Enter a description of the memo.

5.	 Click OK. The memo is opened in edit mode and you can enter the content.

Adding an annotation to selected content
To create an annotation:

1.	 Select the content you want to annotate.

2.	 On the Analyze tab, in the Annotations group, click New Annotation.

3.	 In the Annotations tab at the bottom of Detail View, enter the annotation.

Adding a see also link
To add a see also link from content to another source:

1.	 Select the content you want to link from.

2.	� On the Analyze tab, in the Links group, click See Also Link, and then click  
New See Also Link.     
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Memos - a crucial piece of the analytical puzzle
You can use memos to tell the story of your project—from your early ideas and 
assumptions to fully-fledged insights about a topic, person, or event. Use them to 
‘talk to yourself’ as you make sense of your data.

Tracking your analytical process with memos can help you to increase the 
transparency and reliability of your findings. With your process recorded in memos, 
you can easily demonstrate the evolution of a theory or quickly call up data that 
supports client questions.

Memos are quite ‘free form’ in NVivo and our innovative users (from the LinkedIn 
NVivo Users Group) have come up with some great uses for them:

•	 Project memo—record your goals, assumptions and key decisions. Like a 
journal, update it regularly and include links to the significant theme nodes and 
sources. Bring your journal to life by displaying it in a model.

•	 Interview or participant memo—summarize the key points of an interview. 
Make note of contradictions, surprises or early hunches. Include ideas about the 
nodes you might make and include photos or descriptive information about the 
interview setting.

•	 Node memo—explain why you think a theme is significant (especially useful 
in team projects). Add to the memo as your thinking evolves and include links 
to the related literature. By writing as you go, you won’t face the pressure of 
staring at a blank document when it comes to writing up your project.

•	 Query results memo—what do these query results tell me? Make a memo to 
organize your ideas and to plan future steps. If you display your query results in 
a chart or other visualization, copy and paste it into the memo.

•	 Analytical and procedural memos—record your findings in analytical memos 
and use procedural memos to document the methodological steps you take. 

•	 NVivo memo—record what works best in the software, including any tips 
or shortcuts you want to remember. Include links to NVivo-related support 
materials that you’ve found on the web.

ideas
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Work with demographic data
You can use ‘node classifications’ to capture the demographic details of the people, places 
or other cases in your project. For example, if you have interviewed people in a particular 
community, you may want to collect information about their age, gender and occupation—and 
compare their responses based on these attributes. 

You can setup demographic data in NVivo or you can import it from a spreadsheet or text file. 

Add node classifications to your project 
Before you can classify nodes, you need to add at least one node classification to your project: 

1.	 On the Create tab, in the Classifications group, click Node Classification. 

2.	 In the New Classification dialog box, select the type of classification you want to add: 

	 •    �To add your own custom classification, select Create a new classification and enter  
a name and description.

	 •    �To add one of NVivo’s ready-made classifications, select Add one or more predefined 
classifications to the project and select the check boxes for the  
required classifications. 

3.	 Click OK.

Note: Predefined classifications come with a set of attributes—for example, Person has 
attributes for age, occupation and so on. Custom classifications do not have default 
attributes but you can add your own—select the classification and on the Create tab, in the 
Classifications group, click Attribute.

Classify a node
When you have created the classifications you need, you can classify your nodes:

1.	 In List View, select the node you want to classify.

2.	 On the Home tab, in the Item group, click Properties.

3.	 In the Node Properties dialog, click the Attribute Values tab.

4.	 From the Classification list, select the classification for the node.

5.	� Click the arrow in the Value field to select a value for each attribute. To add a value, click in 
the Value field and enter a new value.

6.	 Click OK.
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Work with classification sheets 
Classification sheets provide an overview of the items in a particular classification. For example, 
if you have created nodes for interview respondents and classified them as Person, you can 
double-click on the classification to quickly see the spread of your respondents:

Import demographic attributes (classification sheets)
If you have demographic attributes in a spreadsheet or text file you can import this data and 
automatically classify the case nodes in your project. For example, to setup node classifications 
for your interview respondents, you could follow these steps:

1.	� Add the node classification Person to your project—on the Create tab, in the 
Classifications group, click Node Classification.

2.	 Select all your interviews in List View.

3.	� Right-click and click Create as Case Nodes and assign the Person classification. NVivo 
makes a new node for each interview and codes the content.

4.	� In your spreadsheet, make sure the interviewee names match the names of the nodes you 
just created.

5.	� Import the spreadsheet—on the External Data tab in the Import group, click  
Classification Sheets. NVivo automatically applies the attributes from the spreadsheet  
to the Person nodes.

Click in a cell to update attribute valuesApply filters to see a subset of your data
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Exploring people, places and other cases
NVivo provides tools for exploring the cases in your project, for example, you could:

•	 Use a matrix coding query to compare your respondent’s comments based on 
demographic attributes:

•	 Create a chart to check the demographic spread of your respondents:

 

•	 After reviewing the content in a case node—make a model to visualize a 
participant’s perceptions and to ‘tell their story’.  

•	 Make a memo to record your thoughts and insights about the case.

ideas
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Summarize your data in framework matrices
You can use framework matrices to summarize your data in a grid format—this is especially 
useful if you are working with interview or focus group transcripts.

The grid has rows for case nodes (for example, people you interviewed) and columns for theme 
nodes—you can enter your summary in the cells where the case and theme intersect. For 
example, you could summarize Anna’s experience of volunteering:

 

Working with condensed source materials in the framework matrix can make it easier to:

•	 See everything about a theme by looking down a column.

•	 See how different themes relate to each other for a particular individual by looking across  
a row.

•	 Compare the experiences of different individuals by comparing one row to another.

Once you have condensed your source materials in a framework matrix, you can easily share 
your data with others by printing the matrix or exporting the matrix to a spreadsheet.

Before you can start working with framework matrices, you need to import your source 
materials, code source content to case nodes, and set up thematic node hierarchies. Refer to the 
NVivo Help for comprehensive information about working with framework matrices.

Associated View displays the content coded at the caseEnter summary text in the cell
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Bring it all together with queries
You can use NVivo queries to:

•	 Find and analyze the words or phrases in your sources and nodes. You can find 
specific words or those that occur most frequently.

•	 Ask questions and find patterns based on your coding, check for coding consistency 
among team members and review your progress.

You can work with queries using the Query tab:

Use queries for text analysis
You can explore the text in your sources using the following queries:

•	 Text Search Query: search for a word or phrase in your source material and view 
all the matches in a preview node—automatically code the content (if you want to). 
Display a word tree to visualize words in context: 

 

•	 Word Frequency Query: list the most frequently occurring words in your sources 
and visualize the results in a word cloud, tree map or cluster analysis diagram:

Display results in a 
word cloud, double-
click a word to gather 
all occurrences in a 
node

Display results in a 
word tree, click a 
branch to highlight 
the context

Easily create 
queries using 
the step-by-step 
Query Wizard
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Use queries to explore your coding
You can review and explore your coding using: 

•	 Coding Query: gathers all the coding at any combination of nodes—for example, 
gather and explore all content coded at water quality and tourism, or find where 
content coded at water quality is near content coded at tourism.

•	 Matrix Coding Query: creates a matrix of nodes based on search criteria. For example, 
show me attitudes about water quality by community. 

•	 Coding Comparison Query: compares the coding of two researchers or two groups of 
researchers. This is useful for teams who are interested in coding consistency and the 
questions posed by researcher disagreement.

•	 Compound Query: combines text and coding queries—search for specified text in or 
near coded content. 

•	 Group Query: finds items that are associated in a particular way with other items in 
your project. For example, list the nodes that code a selection of sources.

Making the most of queries
•	 Start running queries early on in the coding process—they can help you focus 

on the questions you want to ask (and prompt you to code accordingly). For 
example, if you want to ask “How serious are the issues of water quality for 
local fishermen?”—make sure you code at the node for water quality and code 
at case nodes with the fisherman attribute.

•	 Use coding queries to build-up and test ideas. For example, you have a 
hunch that people’s perception of water quality is closely tied to the pace of 
development. Create a query to gather all material coded at water quality 
where it is NEAR content coded at ‘development’.

•	 Use matrix coding queries to compare attitudes based on demographic 
attributes. For example, explore attitudes about water quality by community:

 
 

•	 Make a memo to record what you learn from a query—this can prompt you to 
ask further questions and facilitate deeper analysis. Link the memo to the query 
results.

Double click a cell to 
see the coded content

ideas
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Visualize your project
NVivo lets you explore your data using charts, models and other visualization techniques. 
They can help you to explore trends, test theories and make sense of what is happening in 
your source materials.

Display your data in charts
You can create a chart to present or explore the data in your project. For example, you 
could make a chart to see the nodes that code a source:

 

 
You can create a chart using the Chart Wizard or while working on other areas of your 
project—for example, you can create a chart based on a node, node matrix or source that 
you have opened in Detail View. 

You can also choose from a variety of chart types—for example, 3D bar or column. To 
launch the Chart Wizard—on the Explore tab, in the Visualizations group, click the Chart 
image. Refer to the NVivo Help for comprehensive information on working with charts. 
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Create models and graphs to visualize connections
You can create models or generate graphs to visualize, explore and present the connections in 
your data. You can create models and graphs using options on the Explore tab:

You could create a model to plan your project and sketch your expectations or hypotheses:

You could also generate a graph to see how project items are connected. For example, you 
could see which items are connected to a selected source or node. 

Create a 
new model 

Generate a graph for 
selected sources or nodes

Link shapes to items in 
your project—open items 
directly from the shape

Generate a graph for 
selected sources or nodes 
– you can convert the 
graph to a model
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Work with tree maps and cluster analysis diagrams
You can use other visualization techniques to get a different perspective on what is happening 
in your data—for example:

Use a tree map to compare nodes by the number of references they contain: 

Use cluster analysis to group sources or nodes that share similar words, attribute  
values, or coding:

As you work with sources, nodes or query results you can choose to visualize the data.  
For example, you can display a cluster analysis diagram for a social media dataset or display  
a tag cloud for the results of a Word Frequency query.

Refer to the NVivo Help for more information about working with visualizations.

See patterns of coding in 
your project, or compare 
sources or nodes based on 
their attribute values

Click the Summary tab 
to see the values that 
were used to generate 
the diagram
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Create reports and extracts
As your project grows you can use reports to:

•	 Review and revise your progress

•	 Identify themes that are occurring more than others

•	 Present your findings

Extracts allow you to export a collection of your data to a text, Excel or XML file—you can use 
this data for complementary analysis in other applications.

To run one of NVivo’s predefined reports:

1.	 In Navigation View, click Reports, and then click the Reports folder.

2.	 In List View, double-click the report you want to run.

	 The report results are displayed in Detail View:

To create your own report—on the Explore tab, in the Reports group, click the New Report 
image. Follow the steps in the Report Wizard to choose the fields, filters and layout of your 
report. You can also create your own report (or modify an existing one) using the Report 
Designer—refer to the NVivo Help for more information about working with reports. 

Use this view to 
navigate through the 
items in your report
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